


Balance of power

In our last class (on
Wednesday), we started work
on a fairly simple infographic
that would convey shifts in
the balance of Congressional
power over the previous three
presidential administrations.
What were your ideas on how
to do this?
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FILE FORMATS




Photoshop PSD
Large Document Format PSB
BMP
Cineon
CompuServe GIF
Photoshop DCS 1.0
IMAGES ON THE WEB Photoshop DCS 2.0
DICOM
Photoshop EPS
IFF format
JPEG
JPEG2000
OpenEXR
PCX
Photoshop PDF
Pixar
PNG
Portable Bit Map
Photoshop Raw
Scitex CT
Targa
TIFF

Basic web design holds
that you are limited In
the types of files that
can be used for Images
on web pages.



IMAGES ON THE WEB OK

Basic web design holds JPEG
that you are limited In PNG
the types of files that
can be used for Images
on web pages.

CompuServe GIF

NOT OK

All the others



GIF

(Graphical Interchange Format,
1987)

You probably know of GIFs
(pronounced with a hard G) as
small pieces of looping animation.
The format (which is actually a
soft G) is based on 8-bit colors,
making it 1s poor for photographs,
but good for images with flat color,
like logos or cartoons.




JPEG (or JPG)

(Joint Photographic Experts
Group, 1992)

The best-known lossy format for
digital images, JPEG is especially
useful for photographs, as the
degree of compression can be
adjusted. Compression sacrifices
detall for the sake of economy —
In this case, the size of the file.
(You can use either file il | 3
extension, I Al e
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PNG

(Portable Network Graphics, 1998)

PNG was developed as an
alternative (and improvement)
over the GIF format. It uses
lossless compression, which
means file sizes are reduced
without losing image quality. PNG
flles can be 24-bit, meaning there
are 16 million available colors
rather than GIF's 256. Like GIF,
PNG supports transparency.




PNG

(Portable Network Graphics, 1998)

PNG was developed as an
alternative (and improvement)
over the GIF format. It uses
lossless compression, which
means file sizes are reduced
without losing image quality. PNG
flles can be 24-bit, meaning there
are 16 million available colors
rather than GIF's 256. Like GIF,
PNG supports transparency.




JPG or PNG?

The decision as to whether to use
either of the most widely used
image formats comes down to the
type of file. If it has flat color, or a
need for transparency, PNG is a
better choice. If the image
features continuous tone, JPG Is
ideal, but every image will be
constrained to a rectangle*.

* THE ADVENTURES OF *

TINTIN

*Unless, of course, you use CSS
to make it look different.




Saving for web

For your “balance of power”
graphic, which we will slug CONG,
you can confine the graphic to the
size of an artboard, or you can
“slice” the page to i1solate the
graphic from the background.

This 1s the original graphic, at 600
pixels wide, on a letter-sized piece
of paper (which is 612 “pixels” —
actually points — wide).

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not
for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-
pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS

CONG.
1993-95

1995-97
1997-99
1999-2001
2001-03
2003-05
2005-07
2007-09
2009-11
2011-13
2013-15
2015-17

PRESIDENT

Clinton
Clinton
Clinton
Clinton
Bush
Bush
Bush
Bush
Obama
Obama
Obama

Obama

DEMOCRATS REPUBLICANS

_—
200 | 228
207 | 226
21| 223
213 | 220
205 | 29
201 | 233

SOURCE: U.S. House of Representatives




Snifts in the balance of power

Few presidents have enjoved a high deqree of Conqressiona nport — at least no

or a sustained period. The last three administrations, all two-termers, were swept
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SaVi ng for Web pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS
LONG. PRESIDENT EMOCRATS

To slice, which doesn't cut
anything, as the name suggests,
but divides your image area into
regions, you would select the 10005001 Clinton
graphic, then pull down Object > »001-02  BRush
Slice > Make.

2009-11 Obama
2011-13 Obama
2013-15 Obama
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Shifts in the balance of power

Few presidents have enjoved a high deqree of Conqressiona nport — at least no
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SaVi ng for Web pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS
LONG. PRESIDENT EMOCRATS

For our purposes, It Is better to
reduce the size of the artboard to fit
just the finished graphic. Artboards
In lllustrator are often treated as 100095001 Clintor
pages, but they are much more 200103 Bush
flexible and powerful than that. You
can have multiple artboards of _
different sizes in a document, and 200911  Obama
you can save out multiple files from 201113 Ohama
a single document with them. 2O1Sds - Bhama
For a review on lllustrator’s
artboards, go to
https://helpx.adobe.com/illustrator/
using/artboard-overview.html
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Saving for web

There are several ways
to change the size of an
artboard — you can use
the Artboard tool, as

well as the Artboard
panel, to either drag to
change or specify an
exact size for an
artboard.
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@ lllustrator CC File

Saving for web

The best way, though, Is
to make the dartboard
the exact size of your
Image. To do this,
select the graphic,

pull down Object >
Artboards > Fit to
Selected Art.

Edit

oJJ-la8 Type Select Effect View Window Help

Transform B
Arrange >

Group #G
Ungroup
Lock B> -

Unlock All 18 Al
Hide W o T S e S e TR

pladledl DerOC -l Ie wemel0100110 =1010]0 > NO-LETITIE NEIC NEL

’ ’ WV E

Expand vith firm majorities, only to see those advantages decline and disap-

Rasterize...
Create Gradient Mesh...

.Ak. l. \'A H::

PRESIDENT DEMOCRA
Flatten Transparency... Clinton 258

Slice Clinton 206
Create Trim Marks . 207

226
Path > 211 223
Shape B> 5
Pattern > 213 | 220
Blend > 205 229
Envelope.Dlstort > 201 233
Perspective >
Live Paint = 232 203
Image Trace > 957 178
Text Wrap >
Line and Sketch Art > 193 242
Clipping Mask > Obama 201
Compound Path > Obama 188
Artboards > Convert to Artboards
Graph B

Fit to Artwork Bounds



Saving for web

Your dartboard should
now be the exact size of
the elements in your
graphic. In our case
today, that should be
600 pixels wide (and
however deep).

Shifts in the balance of power

for a sustained period. The last three administrations, all two-termers, were swept
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IBREAKDOWN OF HOUSE MEMBERS
ICONG. PRESIDENT DEMOCRATS : BEPURBI ICANS}

1993-95  gClinton 258 | 176
995- Clinton 206 | 228
199799  Clinton 207 | 226
1999-2001 Clinton 911 ¥ 223
2001-03  Bush 913 | 220
003-0 Rush 205 | | 229
005-07  Bush 201 | 233
2007-09  Bush 232 203
2009-11 Obhama - 257 ‘ 178 j
2011-13 Qhama -193 242 j
013- 201 234
015- 188 247
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JPG or PNG?

JPEG, PNG (or other formats)
can be saved out of programs
like lllustrator by using the
Save for Web function.

This i1s under the File menu In
Illustrator, and i1s now added
to the Export menu of
Photoshop.
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Preset
Name: [Unnamed) v i
PNG-24 v terlaced
GIF Whin - .
JPEG
PNG-8
v PNG-24
Image Size
New Size: Original:
widch: CICHIN ox L
veion: EZTN o AL,
percen: [T
Art Optinsized - v nboard
olor Table o —
Browser Dither
Done Cancel Save



t — at least not

S, were swept
> and disap-

176

226
223
220
229
233
203
178
242

247

Preset

Name: [Unnamed]

PNG-24 v
GIF
JPEG
PNG-8
v PNG-24

Interlaced

ite v .

New Size: Original:
width: CLI px . W: 600 px
Height: m pXx ° H: 560 px

Percent: m
Art Optimized v v/ Clip to Artboard
Color Table =

Browser Dither

Done Cancel Save

Presets

You can set up your image as
a GIF, JPEG or PNG In this
section, depending on your
needs. There are options
within each setting, including
transparency with GIF and
PNG, and the compression
level in JPEG.



t — at least not
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229
233
203
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Preset

Name: [Unnamed] | vis
PNG-24 v Interlaced
GIF Matte: White v .
JPEG
PNG-8
v PNG-24

Image size

Image Size

New Size: Original: . . .
wicth: CI o~ W: 600 px You can set scaling here if you like
e N S (though it's not recommended).
Percent:m .

o — s S You can also set your size to be

the same as the artboard, which
IS recommended for our class.

Color Table

Browser Dither

Done Cancel Save
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S, were swept
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226
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220
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233
203
178
242

247

Preset

Name: [Unnamed] v s
PNG-24 v Interlaced

GIF Matte: White v .

JPEG

PNG-8

v PNG-24
Image Size
New Size: Original:

. ger W: 600 px
Height: EEZINN x B
Art Optimized — v/ Clip to Artboard

Color Table =

Browser Dither

Done Cancel Save

Slices

Slicing your page is especially
useful If you want to save out
a number of assets all at
once. But we will not be using
this technique a great deal for
our visualizations.



Save

If you save slices, Illustrator
will put them in an Images
folder. But for creating a
single PNG image, as you will
do today, you need only save
the document.




Save

Note that when you save this
way, lllustrator adds the

CONG extension. So, if you save your
fille as “cong,” the resulting file
= cong.png will be cong.png.

When you are making images
for the Web, you should only
use lowercase letters in your
flle names, and no spaces
(use hyphens or underscores
instead).



Save

We'll experiment with these
two formats briefly. Save a
png and jpeg version of your

graphic, which should be
&= cong.png 600px wide.

® cong.|pg

CONG




Adding images

Open your website for our
class in Text Wrangler.
Have the index.html page
showing. Hopefully, the
basic structure of the
page Is ready to go.

In the nav tag, If you
haven't already, please
add links to your
class.html page and your
projects.html page.
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File Path v : ~/Desktop/IDV/website/website day 1/index.html

B

(no symbol selected) &

<!DOCTYPE html>

<html>

<head>
<title>IDV460 | Steve Layton </title>
<meta charset="utf-8">
<link

href="https://fonts.googleapis.com/css?family=Roboto:400,900,700,700italic,4001italic’

rel="'stylesheet' type='text/css'>
<link rel="stylesheet" href="css/style.css">
</head>
<body>
<header>
<h1>IDV460</hl1>
<p>Interactive Data Viz Spring 16</p>
<h2>Steve Layton</h2>
</header>

<div id="page-wrap">

<pav>
<ul>
<li><a href="index.html">Home</a></1i>
<li><a href="class.html">Class</a></1i>
<li><a href="projects.html">Projects</a></1i>
</ul>
</nav>
<main>

<h2>About me.</h2>
<p>Some type about me will go right here.</p>

</main>
</div> <!-- closes page-wrap —-—>
<footer>
<p>IDV460</p>
<p><a href="mailto:stlayton@indiana.edu">stlayton@indiana
</footer>
</body>
</html>

.edu</a></p>



| websiteday 1 ~

index.html

Adding images

Go to “Save As”, and
name this page
class.html, saved parallel
to the index.html file.
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File Path v : ~/Desktop/IDV/website/website day 1/class.html

B

(no symbol selected) &

<!DOCTYPE html>

<html>

<head>
<title>IDV460 | Steve Layton </title>
<meta charset="utf-8">
<link

href="https://fonts.googleapis.com/css?family=Roboto:400,900,700,700italic,4001italic’

rel="'stylesheet' type='text/css'>
<link rel="stylesheet" href="css/style.css">
</head>
<body>
<header>
<h1>IDV460</hl1>
<p>Interactive Data Viz Spring 16</p>
<h2>Steve Layton</h2>
</header>

<div id="page-wrap">

<pav>
<ul>
<li><a href="index.html">Home</a></1i>
<li><a href="class.html">Class</a></1i>
<li><a href="projects.html">Projects</a></1i>
</ul>
</nav>
<main>

<h2>About me.</h2>
<p>Some type about me will go right here.</p>

</main>
</div> <!-- closes page-wrap —-—>
<footer>
<p>IDV460</p>
<p><a href="mailto:stlayton@indiana.edu">stlayton@indiana
</footer>
</body>

</html>

.edu</a></p>




Adding images

Write an <h2> for the
JPEG version, then add a
little text to remind you
what this graphic is.
You'll bring in the JPEG
graphic as an image:

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not
for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-

pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS
CONG. PRESIDENT DEMOCRATS E REPUBLICANS
1993-95 Clinton 176

1995-97 Clinton 228
1997-99 Clinton 226

1999-2001 Clinton 211 223
2001-03  Bush 213 220
2003-05  Bush 206 ' 229
2005-07  Bush 200 ' 233
2007-09  Bush 232 203
2009-11  Obama 257 178
2011-13 Obama 193 242

234
247

2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives

<img src="images/graphic.Jjpg" alt="my graphic">




Adding images

Add another image below,
this time bringing in the PNG
file. (Note that you can
specify the size of the
graphic in the image tag as
attributes. This “saves space”
for the graphic to load into.)

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not
for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-

pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS
CONG. PRESIDENT DEMOCRATS E REPUBLICANS

1993-95  Clinton _ 176
199597  Clinton (206 228
1997-99  Clinton 207 | 226
1999-2001 Clinton 211 223
2001-03  Bush 213 220
2003-05  Bush 206 ' 229
2005-07  Bush 200 ' 233
2007-09  Bush 232 203
2009-11  Obama 257 178
2011-13 Obama 193 242

234
247

2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives

<img src="images/graphic.jpg" alt="my graphic"

width="600" height="540" >




Hmmm ...

JPEG and PNG formats are
fine for images —
photographs or logos — but
they are not so good for data
visualizations. Why not?

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not

for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-
pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS

CONG. PRESIDENT DEMOCRATS . REPUBLICANS
1993-95 Clinton 176

1995-97 Clinton 206 228

1997-99  Clinton 207 226
1999-2001 Clinton 211 223
2001-03  Bush 213 220
2003-05  Bush 205 | 229
2005-07  Bush 200 ' 233
2007-09 Bush 232 PAIK]
2009-11 Obama 257 | 178
2011-13 Obama 193 ' 242

234
247

2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives



SVG

There are a number of ways,
fortunately, that we can add
graphics to websites without
having to turn them into
rasterized images. Today, we
will begin to explore the SVG
format. SVG stands for
Scalable Vector Graphics.

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not

for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-
pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS

CONG. PRESIDENT DEMOCRATS . REPUBLICANS
1993-95 Clinton 176

1995-97 Clinton 206 228

1997-99  Clinton 207 226
1999-2001 Clinton 211 223
2001-03  Bush 213 220
2003-05  Bush 205 | 229
2005-07  Bush 200 ' 233
2007-09 Bush 232 PAIK]
2009-11 Obama 257 | 178
2011-13 Obama 193 ' 242

234
247

2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives



SVG

To prepare an SVG version of
your CONG graphic, export it
out of lllustrator as an SVG
(in our version of lllustrator,
you must Save As in SVG
format).

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not

for a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-
pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS

CONG. PRESIDENT DEMOCRATS . REPUBLICANS
1993-95 Clinton 176

1995-97 Clinton 206 228

1997-99  Clinton 207 226
1999-2001 Clinton 211 223
2001-03  Bush 213 220
2003-05  Bush 205 | 229
2005-07  Bush 200 ' 233
2007-09 Bush 232 PAIK]
2009-11 Obama 257 | 178
2011-13 Obama 193 ' 242

234
247

2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives



SVG

There are two ways to insert an
SVG graphic into your page. The
simplest I1s to merely add it as the
source In the image tag, similar to
the way we did with our JPEG and
PNG versions. But as we shall see,
this does not fully take advantage
of what SVG can provide for us.

Shifts in the balance of power

Few presidents have enjoyed a high degree of Congressional support — at least not
or a sustained period. The last three administrations, all two-termers, were swept
Into power with firm majorities, only to see those advantages decline and disap-

pear by the time they left office.

BREAKDOWN OF HOUSE MEMBERS
CONG. PRESIDENT DEMOCRATS i REPUBLICANS

1993-95  Clinton _ 176
1995-97  Clinton 206 228
199799 Clinton 207 | 226
1999-2001 Clinton o211 223
2001-03  Bush 213 220
p003-05  Bush 205 ] 229
2005-07  Bush 201 | 233
2007-09 Bush 232 203
2009-11 Obama 257 178

242
234
247

2011-13 Obama 193
2013-15 Obama 201
2015-17 Obama 188

SOURCE: U.S. House of Representatives

<img src="svg/graphic.svg" alt="svg version">




